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1 INTRODUCTION

Aplicom A-series SW Configurator (hereinafter referred to as the Configurator) is application software for creating
configurations for A11 SW, A11 LTE SW, A9 PRO SW, A9 TRIX SW and A9 NEX SW (hereinafter referred to as A-
series SW), and updating the A-series SW and its configuration to Aplicom A11, A11 LTE, A9 PRO, A9 TRIX and
A9 NEX devices. Each SW is for it’s corresponding device. The Configurator can also be used to install custom
software to the Aplicom A-series devices. 

This document describes the functionality of A-series Configurator. It is essential to be familiar with A-series SW
before using the Configurator. Therefore, it is highly recommended to read the user manual of the A-series device
in use.

The Configurator can update A-series devices locally using serial cable connection and remotely using Over-The-
Air Provisioning OTAP. The Configurator offers three different ways for creating and editing configurations for A-
series SW, configuration wizard, advanced configuration editor and a text editor for editing the XML configuration
files.

1.1 System requirements

A PC that meets the following minimum hardware and software requirements is required for installing and using
Aplicom A-series SW Configurator.

• Microsoft Windows operating system
• Java SE Runtime Environment (version 1.8 or newer) 
• Approx. 20 MB of free disk space for installation.
• One COM port for communication with the device (for local updates and/or usage as a GSM modem).

To use OTAP features of the Aplicom A-series SW Configurator, a server is required. The server must meet the
following minimum software requirements.

• HTTP server.
• Java servlet container that supports Java version 1.8. Apache Tomcat (version 8) is recommended.
• OTAP server components (included in SW Package for A-series).

1.2 SW Package for A-series

Aplicom A-series SW Configurator is delivered as part of the SW Packages for A -series devices.

The SW Packages for A-series devices are available for download in Aplicom extranet: 
http://www.aplicom.com/en/extranet

1.3 System architecture

This  chapter  describes  a  typical  example  of  a  complete  tracking  system built  with  the  A-series devices.  The
example system uses Over-The-Air Provisioning (OTAP) for updating configurations and software of the A-series
devices.

The server must be equipped with an Internet connection with a static IP address or domain name. The example
server  has  a  communication  handler  which  stores  the data  received  from  A-series  units  to  a  database.  The
example server  also  contains  an OTAP server  for  handling OTAP updates.  The  OTAP server  hosts  the files
required for OTAP updates and receives OTAP notifications from A-series units. The OTAP server consists of
HTTP server and Java servlets for processing notification and requests made by the Configurator and A-series
devices.

Aplicom A-series SW Configurator is used to create configurations for A-series SW, and to update software and
configuration of A-series units either locally using a serial cable or remotely using OTAP.
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Figure 1. System architecture.
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2 INSTALLING AND UNINSTALLING

2.1 Installing A-series SW Configurator

Install Java SE Runtime Environment (version 1.8 or newer). Java Runtime Environment is available for download
at Oracle’s web site.

Installation  program  for  Aplicom  A-series  SW  Configurator  can  be  found  in  D208900_A-
series_SW_Configurator directory  in  the  SW  Package  for  A-series  devices or  from  Aplicom  extranet
(www.aplicom.com/en/extranet).  Double  click  A-series_SwConfigurator.exe to  start  the  Configurator
installation program and follow the on-screen instructions to install the Configurator.

The Configurator can be installed over a previous version. The installation program will not replace any settings or
data files of the previous installation.

Click Next to continue. In the next steps the installation program will ask where Aplicom A-series SW Configurator
and shortcuts should be installed. Click Next on both steps to accept the default install locations. Click Finish to
install Aplicom A-series SW Configurator.
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The installation program will ask for permission to install Module Exchange Suite (MES). The MES is required for
updating A-series locally, so it is highly recommended to install MES now (if not already installed).

Select Yes to install MES. The MES installation program will be started.

Click  Next to  proceed.  The  MES  installation  program  will  present  its  licence  agreement.  Read  the  licence
agreement and select Yes to accept the licencing terms for MES. The installation program will install MES.
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Aplicom A-series SW Configurator is now installed and ready to use. Click Finish to exit the installation program.

The installation program created shortcuts for Aplicom A-series SW Configurator on desktop and in start menu.
Double click the desktop shortcut to start the Configurator.

2.2 Uninstalling A-series SW Configurator

A-series  SW  Configurator  uninstallation  program  can  be  started  via  Start  Menu  ->  Aplicom  A-series  SW
Configurator Uninstaller. Alternatively the A-series SW Configurator can be uninstalled via the Windows Control
Panel.

Note! The uninstaller will  not delete the data directory contents (configurations, etc.) if  it's  stored in the user's
application data directory.
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3 CONFIGURATOR OVERVIEW

The Configurator has separate sections for managing different types of A-series devices and their configurations
(vertical tabs on left).

Note! Some sections might not be enabled by default. They can be enabled via Configurator options (Tools ->
Options -> Sections). See chapter 14 for more information about Configuration options.

The CUSTOM SW section of the Configurator are described in chapter 13.

13 (107)



Aplicom A-series SW Configurator User Manual             Confidential 
K530800 rev. 13.2.0         
3.1 Data and log files

The Configurator stores all settings and data files in its data directory. By default, the data directory is the same as
the Configurator  installation directory. Typically,  the default  data directory location is  C:\Program Files\A-
series SW Configurator. Location of the data directory can be changed by editing the properties.xml file.

The data directory has the following structure:

• data (contains configurations and SW)

• a11 (contains configurations and A11 SWs for A11 devices)
• configs
• software

• a11lte (contains configurations and A11 LTE SWs for A11 LTE devices)
• configs
• software

• a9pro (contains configurations and A9 PRO SW IMlet suites for A9 PRO/IPEX PRO devices)
• configs
• software

• a9trix (contains configurations and A9 TRIX SWs for A9 TRIX/IPEX devices)
• configs
• software

• a9nex (contains configurations and A9 NEX SWs for A9 NEX devices)
• configs
• software

• custom (contains custom IMlet suites)
• software

• logs (contains Configurator’s log files)
• debuglog.txt (contains information that is often useful for troubleshooting)
• eventlog.txt (contains information about successful and failed updates)

a11-devices.txt (list of A11 devices)
• a11lte-devices.txt (list of A11 LTE devices)
• a9pro-devices.txt (list of A9 PRO/IPEX PRO devices)
• a9nex-devices.txt (list of A9 NEX devices)
• a9trix-devices.txt (list of A9 TRIX/IPEX devices)
• custom-devices.txt (list of custom devices)
• properties.xml (settings for the Configurator)
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3.2 Main menu

This chapter describes the functionality available through the main menu of the Configurator.

3.2.1 File menu

Note! Items in file menu depend on enabled sections. 

New  <A-series device> configuration (wizard)  Opens a new configuration wizard for the A-series device. See
chapter 6 for more information about the configuration wizard.

New <A-series device> configuration (advanced)  Opens a new advanced configuration editor for the A-series
device. See chapter 7 for more information about the advanced configuration editor.

New <A-series device> configuration (XML) Opens a new XML configuration editor for the A-series device. See
chapter 8 for more information about the XML editor.

Quit Exits the Configurator.

3.2.2 Log menu

View event log

Displays the event log of the Configurator. All successful and failed update and delete operations are logged into
the event log.

View OTAP log

Displays  the  log  of  the  OTAP  server.  The  OTAP  log  contains  information  about  OTAP  update  and  delete
operations. See chapter 12 for more information about OTAP functionality.
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View data directory

Views the Configurator data directory.

3.2.3 Tools menu

Options

Opens the Configurator Options window. See chapter 14 for more information about the available options.

View SW versions

Displays the SW versions window, that lists the software versions used by the Configurator. Following information
is displayed:

• A11 SW version
• A11 LTE SW version
• A9 PRO SW version
• A9 NEX SW version
• A9 TRIX SW version
• Custom software name and version.

Note! Version information for each software is displayed only if the relevant Configurator section is enabled.

The listed software versions will be used when updating the devices using local and OTAP updates.

Configure Java auto-start

Opens the Java auto-start configuration window. See chapter 15 for more information about configuring
the Java application auto-start.
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Select A11 SW for updates

Selects a new A11 SW version that will be used by the Configurator when updating A11 devices.

The Configurator will ask for a location of Java Application Descriptor (JAD) file of the new A11 SW version. The
Configurator expects to find the new A11 SW JAR file in the same directory and with the same name as the
selected JAD file. After the new A11 SW is selected, the Configurator displays the SW versions window.

Note! The selected IMlet suite is copied to data/a11/software directory in the Configurator’s data directory.

Select <A-series device> SW for updates

Selects a new SW version that will be used by the Configurator when updating the selected devices (A11, A11 LTE,
A9 PRO etc.)

The Configurator will  ask for a location of  Java Application Descriptor (JAD) file  of  the new SW  version. The
Configurator expects to find the new JAR file in the same directory and with the same name as the selected JAD
file. After the new SW is selected, the Configurator displays the SW versions window.

Note! The  selected  SW is  copied  to  data/<device name>/software directory in  the Configurator’s  data
directory.

Select Custom SW for updates

Selects a new custom SW version that will be used by the Configurator when updating custom devices.

The Configurator will ask for a location of Java Application Descriptor (JAD) file of the new custom SW version. The
Configurator expects to find the new custom SW JAR file in the same directory and with the same name as the
selected JAD file. After the new custom SW is selected, the Configurator displays the SW versions window.

Note! The selected IMlet suite is copied to data/custom/software directory in the Configurator’s data directory.

Delete data from A-series

Locally deletes data (SW, configurations, logs, etc) from selected devices. See chapter 11.4 for more information
about deleting data from A-series device.

Delete <select A-series device> SW (OTAP)

Deletes the selected SW and its configuration from selected devices using OTAP. See chapter  12.3 for more
information about the OTAP delete functionality.
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Delete Custom SW (OTAP)

Deletes a custom SW from selected devices using OTAP. See chapters 13.3 and 12.3 for more information about
the OTAP delete functionality.

3.2.4 Help menu

About

Displays the Configurator version information.

User Manual

Displays the Configurator User Manual (this document) as a PDF file.

Note! The  User Manual menu  item is  available  only if  the Configurator  User  Manual  PDF is  found in  the
Configurator installation directory. The User Manual PDF is not included in the Configurator Installation program.
However, if the installation program is started from the SW Package for A-series, it automatically copies the User
Manual PDF to the Configurator installation directory.
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4 QUICK START

This chapter provides step-by-step instructions to configure the device to send position data to a mobile phone
using SMS when

• A11 SW starts.
• Ignition (IGN) line changes state.
• The device has travelled one kilometre since last DISTANCE_TRAVELED message was sent.

Chapter 4.1 describes the steps required to create the configuration and chapter 4.2 describes the steps required
for installing the configuration to A11 device.

Tip! A11 is used in this example but configuring other A-series devices is very similar.

4.1 Creating a configuration

1. Open the configuration wizard by selecting File -> New A11 Configuration (wizard).
2. Enter a name and version for the configuration.

3. Click the Next button to proceed to configure communication settings.
4. Select T protocol verbose (human-readable) from the Message format drop-down list.
5. Select SMS from the Communications type drop-down list.
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6. Enter your mobile phone number to the Phone number field. The phone number must be in international
format, for example +358012345678. The international format beginning with ‘00’ is not accepted.

7. Click the Next button to proceed to configure the events that should be reported by the device.

8. Select at least following events:

• SOFTWARE_START
• IGN_ON
• IGN_OFF
• DISTANCE_TRAVELED
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9. Click the Next button to proceed to configure parameters for the events.
10. Check the Generate an event every X meters check box in default parameter set and enter 1000

as the parameter value. The other parameters are not used in this configuration. 
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11. Click the Save and Close button to save the configuration and close the wizard. The new configuration
will appear in the configuration list.
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4.2 Installing the configuration to A-series device

To use the newly created configuration, it must be installed to A-series device.

First steps for devices with USB (A11, A11 LTE and A9 PRO):
1. Connect the device to computer using a standard micro USB cable between 
2. Open the Configurator Options dialog by selecting Tools -> Options.
3. Select the correct computer serial port from the COM port for local updates drop-down list and click the OK

button to close the options dialog. Select one of the USB interface’s virtual COM ports (Nameless Cinterion
EhxUSB Modem port or one of Cinterion Ehx USB Com Ports 3 – 5. Note! Ports 1 and 2 cannot be used.)

First steps for other devices:
1. Connect the A-series device to computer using a data cable between COM1 of the device and a serial port

of the computer. Connect data cable D337055 to the Serial connector of the device.
2. Open the Configurator Options dialog by selecting Tools -> Options.
3. Select the correct computer serial port from the COM port for local updates drop-down list and click the OK

button to close the options dialog.

Last steps common for all A-series devices:
4. Select the Device list tab to view the device management section of the Configurator.
5. Select the newly created configuration from the drop-down list in Local Update section.
6. Power on the A-series device and switch the IGN line on. On all A9 devices, use DIN1/IGN line (IGN is

default).
7. Click the Update Local button to install the new configuration to A-series device. See chapter 11 for more

information about local update.
8. After the update is completed, the device will restart and take the new configuration in use.

After the above steps the device will send an SMS to your mobile phone every time when:
• Software starts.
• Ignition (IGN) line changes state.
• The device has travelled one kilometer since last DISTANCE_TRAVELED message was sent.

See chapter 11 for more information about the local update.
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5 CONFIGURATION MANAGEMENT

The Configuration list tab contains a list of available configurations and provides functionality to add, edit
and remove configurations. When the Configurator is started for the first time the configuration list will contain the
example configurations. 

5.1 Configuration list

All configurations are listed in the configuration list. Each configuration is identified by its name and version number.
As a side effect, changing the name or version number of a configuration will create a copy of the configuration.
This doubles as a very simple backup and version control functionality as the old versions are always kept in the
configuration list.

The configuration files are stored in the Configurator’s data directory. See chapter 3.1 for more information about
contents of the data directory.

5.2 Creating a new configuration

Click  the  Create (wizard) button  to  create  a  new  configuration  using  the  configuration  wizard.  A  new
configuration wizard will be opened. See chapter 6 for more information about the configuration wizard.

Click the Create (advanced) button to create a new configuration using the advanced configuration editor. A
new advanced configuration editor tab will be opened. See chapter  7 for more information about the advanced
configuration editor.

Click the Create (XML) button to create a new configuration and open it in the XML editor. A new XML editor tab
will be opened with a template configuration. See chapter 8 for more information about the XML editor.

5.3 Editing a configuration

Configuration wizard

Select  a  configuration  from  the  list  and  click  the  Edit selected (wizard) button  to  open  an  existing
configuration for editing in the configuration wizard. Note that the configuration wizard only supports editing simple
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configurations. If the selected configuration has been created or modified outside the configuration wizard, some
configuration settings may be lost. The configuration wizard displays a warning if it does not know how to handle the
selected configuration. See chapter 6 for more information about the configuration wizard.

Advanced configuration editor

Select  a  configuration from  the list  and click  the  Edit selected (advanced) button to  open an existing
configuration  for  editing  in  the  advanced  configuration  editor.  See  chapter  7 for  more  information  about  the
advanced configuration editor.

XML editor

Select a configuration from the list and click the Edit selected (XML) button to open an existing configuration
for editing in the XML editor. Note that changing the name or version attributes of the configuration’s root tag will
create a new configuration and leave the old configuration intact. See chapter 8 for more information about the XML
editor.

5.4 Deleting configurations

Select  the configurations to delete and click  the  Delete selected configurations button to delete the
selected configurations. The Configurator will ask for confirmation before deleting the configurations.

5.5 Importing and exporting configurations

Click the Import configuration button to import a configuration to the configuration list. The Configurator will
display a window for selecting the XML configuration file to import. 

Select one or more configurations from the list and click the  Export selected configurations button to
export the selected configurations. The Configurator will display a window for selecting location for the exported
XML configuration files.

Note! An imported configuration is copied to data directory of the Configurator. Therefore, modifying the imported
configuration in the Configurator does not modify the original configuration that was selected during import and vice
versa.

5.6 Searching configurations

The configuration list has a search bar that can be used to search for configurations by one or more field. Type
search terms in the fields of the search bar and press Enter to search configurations. The configuration list will be
limited to configuration that match the entered search terms. Click the X button in top-left corner of the configuration
list to clear all search terms and reset the configuration list display to all available configuration.
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6 CONFIGURATION WIZARD

Select  File -> New  <select A-series device> configuration (wizard) to start  building a new
configuration using the configuration wizard. A new configuration wizard can be opened also by clicking the Create
(wizard) button on the Configuration list tab.

Configuration wizards for all devices are described in chapters starting from 6

6.1 Buttons

There is a row of buttons at the bottom of the configuration wizard:

Next Moves to next page in the configuration wizard.

Back Moves to previous page in the configuration wizard.

Validate Validates the configuration. If the current configuration contains any errors, the Configurator displays the
found errors. See chapter 9 for more information about the validation.

After validation, an error and warning indicators (!!) are displayed next to the field that contains an error. Hold the
mouse cursor above the error indicator for a short time to view the reason for the error.

The error indicators are displayed until the next validation.

Save Saves the configuration. The configuration is validated before it is saved.

Save and Close Saves the configuration and closes the wizard. The configuration is validated before it is saved.
 
Close without saving Closes the wizard without saving the configuration.
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6.2 Wizard steps

The configuration wizards are designed to provide a simple way to create simple configurations.  Configuration
wizard supports one communication method for GPS data, two parameter sets, any number of geofences and
digital inputs of the device. Configuration wizard can create configurations that send a message to a server using
GPRS or SMS when any of the selected events occurs. Configuration wizard supports following events:

• SOFTWARE_START
• IGN_ON
• IGN_OFF
• START_MOVING
• STOP_MOVING
• DIRECTION_CHANGED
• DISTANCE_TRAVELED
• SPEED_LIMIT     
• IBUTTON
• ALARM_ACTIVE
• GEOFENCE
• INPUT_CHANGED

The  configuration  wizards  are divided  into  several  steps.  Each  step  defines  one  specific  part  of  an  SW
configuration. A short help text is displayed on each wizard step. This chapter describes the configuration options
supported by the configuration wizard. See the device’s SW user manual for more information about configuring the
SW.

The wizard steps are listed on the left side of the wizard. The wizard steps can be completed in any order. Use the
wizard step list or Next and Back buttons to navigate between the wizard steps.
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6.2.1 General

The General step defines general configuration settings.

Configuration name and version

The name and version of this configuration. The configurator identifies each configuration by its name and version.
The name and version set here will  be displayed in the configurations list on the Configuration list tab.

Save last used parameter set

If this option is selected, the SW saves the parameter set it was using during shutdown. The saved parameter set
will be used next time when the SW starts. If this option is not selected, the default parameter set will be activated
every time the SW starts. The parameter sets are defined in the Parameters step. See chapter  6.2.4 for more
information about the Parameters step.

Use non-volatile message queue

If this option is selected, the SW will store the message queue to disk when communication is not possible. The SW
will send start sending the stored messages when the communication is possible again. If this option is not set, the
SW will discard messages if the communication is not possible.
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6.2.2 Communications

The Communications step defines how the SW communicates with a server. The server could simply be just a
mobile  phone that  receives  SMS messages or  it  could  be a  custom-built  server  application that  does further
processing on the data received from the device.

Note! These communication settings are only used for sending regular snapshots. 

Message format

The message format defines the protocol for formatting and transmitting the messages. Available protocols are
compact and verbose T protocol, D protocol and G protocol for device supporting it.

T protocol is a human-readable plain text protocol. T protocol’s verbose format contains name and value of each
field on it's own line and compact format contains semicolon separated values and no field names. See S100301
Aplicom T Protocol Specification for more information about T Protocol.

D protocol is a machine-readable binary data format. The benefit of using the D protocol is its much smaller packet
size compared to the T protocol. See  S100300 Aplicom D Protocol Specification for more information about D
Protocol.

G protocol is also a machine-readable binary data format. The benefit of using the G protocol is its new features
and grouped structure compared  to  the  G protocol.  See  S100304 Aplicom G Protocol  Specification for  more
information about G Protocol.

Communication type

Two types of communications are available, GPRS and SMS.

Communication parameters

Communication parameters define the destination for messages sent by the SW. For SMS communication, a phone
number is required. For GPRS communication, Connection type (TCP/IP or UDP/IP), GPRS network settings
(APN,  user name and  password)  and  Destination must  be specified.  A  Destination consists of  an IP

29 (107)



Aplicom A-series SW Configurator User Manual             Confidential 
K530800 rev. 13.2.0         
address or domain name and a port number. An IP address of a Domain Name Server (DNS) must be specified, if a
domain name is used as the Destination.

6.2.3 Functionality

The functionality phase defines the events that the SW reports to a server. An event snapshot is sent using the
communication settings defined in communications phase whenever any of the selected events occurs. An event
snapshot contains the state of the device at the time of the event occurrence and information about the event.

Note! Used parameter set affects the detection of some of these events. If the corresponding setting is not set in
the parameter set, the event snapshot will not be sent. 
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6.2.4 Parameters

Parameters affect the behaviour of the device. These parameters are grouped into parameter sets. Two parameter
sets can be defined in the configuration wizard, default and alternative.

Each parameter set contains following parameters.

Generate an event every X meters

Defines the distance in meters that must be travelled between two consecutive DISTANCE_TRAVELLED events. 

Consider moving if moved X meters in Y seconds

Defines the thresholds for movement detection.

Detect direction change when turned X degrees in Y seconds

Defines the thresholds for direction change detection.

Speed limit

Defines the velocity threshold for GPS based speed limit check. 

When idle, send alive message every X seconds

If this option is enabled the device will send an alive message when no other messages have been sent for the
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defined time period. See the device’s SW User Manual for more information about alive messages.

Power off delay after IGN off

If this option is enabled, the A9 device will stay operational for the specified time after the ignition (IGN) is switched
off. If this option is disabled, the A9 device will go into sleep mode immediately after IGN is switched off. 

6.2.5 Geofences

The geofences phase configures the geofences used by the device. Each geofence defines geographical location
defined by its center point and radius. Also box and polygon geofences are supported. Parameters for box and
polygon geofences are edited with XML editor. Each configuration can have zero or more geofences. 

Note! It is not recommended to define overlapping geofences. Having two or more geofences overlap can cause
the GEOFENCE events to be generated in unpredictable order. In wizard configuration this could result in incorrect
parameter set being activated when the overlapping geofences are visited.

To create a geofence, click the Create button to create a new geofence. The Configurator will ask for a name for
the geofence. The new geofence will appear in the geofence list and its details will be displayed. 

To rename a geofence, select a geofence from the list and click the Rename button. The Configurator will ask for a
new name for the geofence.

To remove a geofences, select one or more geofences from the list and click the Remove button. The Configurator
will ask for confirmation before removing the selected geofences.

The following settings can be configured for each geofence. 

Latitude

Latitude of geofence's center point in decimal latitude degrees. Period must be used as decimal separator. Negative
latitude is southbound and positive latitude is northbound. 
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Longitude

Longitude of geofence's center point in decimal longitude degrees. Period must be used as decimal separator.
Negative longitude is westbound and positive longitude is eastbound. 

Radius

Radius of the geofence in meters.

Parameter set

The selected parameter set will be used whenever the vehicle is inside this geofence. The default parameter set is
always used when the vehicle is not inside any geofence.

Send snapshot on enter

If this option is selected, the SW will send an event snapshot when the vehicle enters this geofence area. 

Send snapshot on exit

If this option is selected, the SW will send an event snapshot when the vehicle exits this geofence area. 

6.2.6 Inputs

The  Inputs phase is  used to select  which inputs are monitored.  A threshold value can be defined for  each
analogue input. The wizard always sets the measurement  range for  analogue inputs to 0..5000 mV.  The SW
monitors each input line and sends an event snapshot when any of the selected events occur.
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6.2.7 FMS-CAN / Tachograph communications

The FMS-CAN / Tachograph communications step defines GPRS communication settings for sending FMS-
CAN and tachograph snapshots to a server.
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6.2.8 FMS-CAN

The FMS-CAN phase configures the FMS-CAN parameters and selects events to monitor. A FMS-CAN snapshot is
sent to server when any of the selected events occurs. The FMS-CAN snapshots are sent using the communication
settings defined in FMS-CAN / Tachograph communications step.

Note! FMS-CAN snapshots are always sent using F protocol. See S100302 Aplicom F Protocol Specification for
more information about F protocol.
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7 ADVANCED EDITOR

Select  File ->  New <A-series device> configuration (advanced) or  File ->  New  <A-series
device> configuration (advanced) to start building a new configuration using the advanced configuration
editor.  The advanced configuration editor can be opened also by clicking the  Create (advanced) or  Edit
selected (advanced) button on the Configuration list tab.

The XML configuration sections are described in detail in Configuration syntax chapters of corresponding A-series
device’s SW User Manual.

This document does not explain all individual settings found in the advanced editor pages. Instead, only the key
elements of the advanced editor user interface are described here. Meanings and valid values of the individual
settings on each page can be found in corresponding chapter of selected A-series device’s SW User Manual.

7.1 Buttons

There is a row of buttons at the bottom of the advanced editor:

Next

Moves to next page.

Back

Moves to previous page.

Validate

Validates the configuration. If the current configuration contains any errors or warnings, the Configurator displays a
list of found errors and warnings. See chapter 9 for more information about the validation.

After validation, an error and warning indicators (!!) are displayed next to the field that contains an error. Hold the
mouse cursor above the error indicator for a short time to view the reason for the error.

The error indicators are displayed until the next validation.

Save

Saves the configuration. The configuration is validated before it is saved.
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Save and Close

Saves the configuration and closes the advanced configuration editor. The configuration is validated before it is
saved.

Close without saving

Closes the advanced configuration editor without saving the configuration.

7.2 Item lists

Many of the advanced editor pages consist of a list of items and an editor for those items. In this chapter the
Actions and Event handlers lists are used as an example.

A list of available items (actions in the above example picture) is on the left. An editor for single item is displayed on
the right side of the list.

The item list looks exactly the same on all advanced editor pages that utilise the item list. The item editor is different
for each type of item.

Below the item list, there are buttons for adding, renaming and deleting items from the list.
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7.2.1 Create

Click on the Create button to add an item to the list. The Configurator will ask for a name for the new item. Enter
the name of the new item and click OK to accept the entered name and create the item.

7.2.2 Rename

Select an item from the item list and then click on the Rename button to rename the selected item. The Configurator
will ask for a new name for the selected item. Enter a new name for the item and click OK to accept the new name.

7.2.3 Remove

Select one or more items from the item list and then click on the Remove button to remove the selected items. The
Configurator will ask for a confirmation before removing the items. Click OK to remove the selected devices.

7.2.4 Duplicate

Select an item from the item list and then click on the Duplicate button to create a copy of the selected item. The
Configurator will ask for a name for the new item. Enter the name of the new item and click  OK to accept the
entered name and create the item.
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7.3 Value lists 

Value lists are used to display and edit a list of values. The items in a value list are separated by one of the value
separator characters: white space (space, tab or line break), comma (,) or semicolon (;).

For example, the LAI codes parameter of Net changed event handler is displayed as a value list:

7.4 Hex strings / binary data

Some parameters accept a hex string or binary data as their value. A hex string must start with 0x, which must be
followed by even number of hexadecimal digits (0-9, A-F). Lower case digits are also accepted.

Text fields that support hex string values have a Value is a hex string checkbox below them. This checkbox
must be selected in order to enter a hex string value. Otherwise the value is interpreted as a normal string value.

For  example,  the  Default  data  parameter  of  Send  data  action  accepts  a  hex  string  value.  Hex  string
0x00207F8099ABCDFF is  interpreted as binary data value containing 8 bytes (0x00, 0x20, 0x7F, 0x80, 0x99,
0xAB, 0xCD and 0xFF) by A-series SW.

If  the  Value is a hex string checkbox  in  the  above  example  is  deselected,  then the  value  would  be
interpreted as a normal string value “0x00207F8099ABCDFF”.
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7.5 Advanced editor pages

This chapter briefly introduces the pages of the advanced editor. The advanced editor pages are in the same order
as the XML configuration sections are described in the  Configuration syntax chapters of corresponding A-series
device's SW User Manual.

7.5.1 General

The  General page is used to define name and version for the configuration and to define which parameter set
should be loaded at start-up.

If the selection “Enable reporting version information to Aplicom server” is selected, anonymous version information
about the device's software is reported to Aplicom server. The version reporting is needed for A-GPS, so if it is used
the reporting is enabled regardless of the checkbox's setting.

If the selection “Save flag states on shutdown” is selected, flag states are stored at shutdown so that they hold their
value over the power cycle (Proxy usage flag, Tacho DL flag and Card DL flag are cleared at shutdown).

40 (107)



Confidential     Aplicom A-series SW Configurator User Manual
     K530800 rev. 13.2.0

7.5.2 Parameters

The Parameters page is used to define parameter sets for the configuration.

7.5.3 I/O config

A11 is used as an example in this section. 

The I/O config page is used to configure the I/O interfaces of A-series.

AD  thresholds,  read  interval  and  measurement  range  is  defined  in  the  AD  and  digital  input
configuration section.  Default threshold for AD inputs 1 to 4 is required. If any other AD or power supply
threshold value is empty, it will not be written to the configuration file.

A flag is bound to each digital input of the device. The Input flag change time determines the time an input
must be in its new state before the bound flag is updated. If left empty, the value is not written to configuration and
flag is not updated automatically. The  Input flag change time parameters do not affect  INPUT_CHANGED
events in any way.
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Digital output or open collector operating mode can be selected separately for each output of  the device in the
Output configuration section. A9 has also buzzer mode which is used to control external buzzer.

Type and parameters of 3PAD can be configured in the 3PAD configuration section.
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7.5.4 Connections

The Connections page is used to define data connections between A-series device and server.

Configuration variables can be used for parameters Username, Password, DNS Server Address, and Access Point
Name to allow changing connection parameters at runtime. See chapter Configuration variables in corresponding A-
series device’s SW User Manual for more information about variables. 

Note! A connection is enabled only when the configuration contains a transport that uses the connection. Therefore,
it is necessary to configure a transport that uses the connection even if  the connection is only used to receive
DATA_EVENTs.

Note! COM2 – COM5 connections are supported only in A11 devices.
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7.5.5 Transports

The Transports page is used to define the transport methods, data formats and destinations for sending data
packets from A-series device to server. 

A special connection, [COM1], is always available in the Connection drop-down box.

Message format can be customized separately for each transport by selecting which fields to include in the sent
snapshot. If the Select fields to include in snapshots sent using this transport option is not
enabled, a default set of fields is selected. The field selection is only available for binary protocols G, D, E and F.
See  the device’s  SW  user manual  and the G,  D,  E and F protocol  specifications for  more information about
customizing the binary protocols.

Configuration  variables  can  be  used  for  parameter  Destination Address to  allow  changing  connection
parameters at runtime. See chapter Configuration variables in the device’s SW user manual for more information
about variables.

Transport parameter Queue Size defines a maximum number of messages that are kept in the dynamic memory.
Due to technical reasons in snapshots saving, when expecting to have a long period of disconnection from mobile
network,  queue  size  should  be  increased.  Queue  size  under  20  messages  combined  with  a  long  period  of
disconnection from the network can cause unexpected behaviour. This can be avoided by increasing the queue size
to 30 or even 50 messages depending on expected network connectivity.

7.5.6 Alarms (timers)

The  Alarms (timers) page is used to define alarms or timers. Once an alarm is activated and the optional
Delay has  passed,  an  alarm  generates  events  with  the  configured  Event interval.  An  alarm  will  keep
generating events until it is deactivated. It is possible to deactivate the alarm before the Delay has passed, in which
case the alarm will not generate any events.

Click the Create actions for this alarm button to create new actions for activating and deactivating the
currently selected alarm. Existing actions are not changed or overwritten.
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7.5.7 Scheduled Events

The  Scheduled events page  is  used  to  define scheduled events.  Scheduled events  are  generated at  the
specified time and optionally repeated with set time interval. 
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7.5.8 Geofences

The Geofences page is used to define geofences. A geofence is a circular region that is defined by location of its
centre  point and its  radius.  Also box and polygon geofences are supported.  Parameters for  box and polygon
geofences are edited with XML editor. Geofences generate events when entered or left. 
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7.5.9 Actions

The Actions page is used to define actions that can be performed in response to an event.

The parameters that are available for an action depend on the selected action type. See the Action reference
appendix of corresponding A-series device’s SW User Manual for more information about available actions and
their parameters.

All event handlers that reference the currently selected action are listed in the This action is assigned to
following event handlers list.  The  list  is  updated automatically whenever  the action  is  assigned to  or
removed from an event handler.
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7.5.10 Event Handlers

The Event handlers page is used to define event handlers to process events generated by A-series SW. Each
event handler processes a specific type of events. One more actions can be assigned to each event handler. 

The parameters that are available for an event handler depend on the selected  event type.  See the  Event
handler  reference appendix  of  corresponding  A-series  device’s SW  User  Manual for  more  information  about
available event handlers and their parameters.

The actions are assigned to event handlers using the Available actions and Assigned actions lists. The
actions that can be assigned to the selected event handler are listed in  Available actions list  on left and
actions that have been assigned to the selected event handler are listed in the Assigned actions list on right.

To assign action to event handler, select the action from the Available actions list and click the --> button.

To remove assigned action from event handler, select the action from the Assigned actions list and click the
<-- button.

Use the Up and Down buttons to change the order of selected actions.
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7.5.10.1 Conditional event handlers

Event handlers can be made conditional, that is, the actions assigned to event handler are only processed when the
specified conditions are met.

Conditions are defined by selecting which flags should be on and which flags should be off. The conditions are
enabled or disabled by selecting a match mode:

• Unconditional: actions assigned to the event handler are always processed. Conditions are disabled.
• All conditions must be met: actions assigned to the event handler are processed, only if all of the 

flags in Require flags on list are set and all of the flags in Require flags off list are cleared.
• Any of the conditions must be met: actions assigned to the event handler are processed, only if at 

least one of the flags in Require flags on list is set or at least one of the flags in Require flags
off list is cleared.
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7.5.10.2 Example of conditional event handler

Consider an event handler, which has conditions defined as follows:

• Match mode is All conditions must be met.
• Require flags on list contains flags Logged In and Door Closed.
• Require flags off list contains flags Moving and Within City Area.

The configuration sets the flags so that

• Logged In is set when the user is logs in and cleared when user logs out.
• Door Closed is set when the driver side door is closed and cleared when driver side door is opened.
• Moving is set when the vehicle starts moving and cleared when the vehicle stops.
• Within City Area is set when the vehicle enters a defined city area and cleared when the vehicle 

leaves the city area.

The actions assigned to this event handler would be processed only if user is logged in, door is closed, vehicle is
not moving and vehicle is outside of the defined city area.

If the Match mode is changed to Any of the conditions must be met, the actions assigned to this event
handler would be processed if user is logged in, door is closed, vehicle is not moving or vehicle is outside of the
defined city area.

7.5.11 CAN Interface

The CAN interface (1 and 2) pages are used to configure parameters for the CAN interface parameters.
Both pages are identical apart from the port number.

For A9 devices, the CAN ID Forwarder is configured on it’s own page.

51 (107)



Aplicom A-series SW Configurator User Manual             Confidential 
K530800 rev. 13.2.0         

52 (107)



Confidential     Aplicom A-series SW Configurator User Manual
     K530800 rev. 13.2.0

7.5.12 Tachograph 

The  Tachograph page is used to configure the tachograph interface and select which events from tachograph
device are enabled.
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7.5.13 Command listener/debug interface 

The Command listener/debug interface page is used to configure the COM1 interface of A-series SW. See
K503052  A-series  SW  COM1 Interface  Command  Reference  Manual for  more  information  about  the  COM1
interface.

Note! The port selection is available only for A11 device.
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7.5.14 Flags 

The Flags page is used to define names for the flags used in the configuration.

The Changed by actions list displays all actions that change the state of the currently selected flag. The Used
by event handlers list displays the event handlers that monitors the state of this flag. These lists are updated
automatically.

Click the Create actions for this flag button to create new actions for setting and clearing the currently
selected flag. Existing actions are not changed or overwritten.

7.5.14.1 Automatically set flags

The device SW automatically updates some flags, for example:

• GSM/GPRS jamming detected
• GPS jamming detected
• 3PAD extra LED 1 ON
• 3PAD extra LED 2 ON
• 3PAD button LED 1 ON
• 3PAD button LED 2 ON
• 3PAD button LED 3 ON
• DIN 1 high
• DIN 2 high
• DIN 3 high
• DIN 4 high
• DIN 5 high
• DIN 6 high

The full list for each A-series device can be seen on the  Conditions part for each event handler in the Event
handlers page.

The DIN flags must be enabled by setting the input flag X set time parameters in the I/O config section.
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The DIN X high flag is set when digital input X has been low for input flag X set time milliseconds. The
DIN X high flag is cleared when digital input X has been low for input flag X set time milliseconds.

The AT proxy connected flag is set when the proxy enters connected mode and cleared when the proxy returns
to command mode.

All flags are cleared initially when the A-series SW is started. The flags are updated to correct values after the A-
series SW has finished starting up.
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7.5.14.2 Setting and clearing flags

Flags can be set or cleared with the CHANGE_FLAGS action. Flags listed in Set these flags list are set and
flags listed in  Clear these flags list are cleared when the action is performed. The action in the following
picture will clear all flags.
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7.5.15 RDL Tacho DL

The  RDL Tacho DL section is used to configure reading of tachograph connected to the device. Tachograph
should be RDL capable for RDL to function.

See the SW user manual of the used device for more information about Tacho DL and it's configuration.
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7.6 CAN ID Forwarder option (with SW option only)

The CAN ID Forwarder option is configured in the CAN interface 1 or 2 section of the advanced configuration
editor. It can be enabled at the same time with the other interface selected, for example FMS.

Select the  Enable CIF check box to enable the CAN ID Forwarder option. Select one or more  Mailbox X
message IDs check boxes to enable configuration of individual mailbox parameters.

For A9 devices, the CAN ID Forwarder is configured on it’s own page.
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7.6.1 CAN ID Forwarder commands

SEND_DATA action can be used to send commands to the CAN ID Forwarder option. Create a SEND_DATA action
and click the Set CAN ID Forwarder command button to open a new command window.

 

Select the command type and other parameters and click  OK to set  the new command to  Data parameter of
SEND_DATA action.
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7.7 Garmin interface configuration

This chapter describes the Garmin interface specific features of the advanced configuration editor. See S100320
Aplicom Garmin interface protocol for more information about the Garmin interface.

Garmin interface available as an option for A-series devices.

7.7.1 Handling events from Garmin interface

Event handle type Garmin event can be used to handle events from the Garmin interface. The following example
handles CONNECT events where the connected device supports interface version 2 and runs Setup Garmin action
whenever the event occurs.

The Garmin event type parameter specifies the type of Garmin event handled by the event handler.

For each Garmin event type there is a different set of parameter filters available. Parameter filters can be used
to define event  handlers  that  only handle specific  type of  Garmin events with  specific  parameters.  Wild  card
characters  * and  ? can be used in all  parameter  filters.  Asterisk  (*)  matches any number of  characters and
question mark (?) matches exactly one character.
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7.7.2 Sending commands to Garmin interface

The SEND_DATA action can be used to send commands to Garmin interface. Following example action sends two
commands to Garmin interface. One to set three predefined responses to connected Garmin navigator and another
to ask if the driver is available.

It is possible to add several commands to a single SEND_DATA action. The number of commands in one action is
limited by the command queue size of the Garmin interface. See chapter  7.7.3 for more information about the
command queue size.

The Configurator offers a graphical user interface for building Garmin interface commands. Click  Add Garmin
command button to open the Add Garmin Command window.
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Select  Garmin command type and set  the parameter values.  Click  OK to append the command to the  Data
parameter of the Send data action.

7.7.3 Garmin interface parameters

Parameters  for  Garmin  interface  can  be  configured  in  the  Garmin interface section  of  the  advanced
configuration editor.

The Command queue size parameter defines the size of incoming command buffer of the Garmin interface. The
command buffer is used in situations where the command can not be processed immediately, for example:

• Connection to Garmin has not been established yet or Garmin has been disconnected.
• Multiple commands are sent to Garmin interface at once.

When the command buffer is full and new command is received, the oldest stored command is discarded to make
room for the new command.

When the  Use unicode (UTF-8) messaging in Garmin interface checkbox is selected, all Garmin
events are presented as UTF-8 instead of ASCII. The server should also encode all Garmin commands as UTF-8.
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7.8 Temperature monitoring

“Temperature monitoring” tab has the parameters for configuring the different ways to monitor temperature with an
A-series device.

7.8.1 Cold Chain Temperature SW option

Temperature limits can be set for max. 6 sensors. The limits are given in tenths of a degree (Celsius), for example
value 185 equals 18.5 degrees Celsius.

Time threshold to trigger alarm represents the time that the temperature has to be over or below a limit before a
configuration based alarm is generated.

Cold Chain Temperature SW option needs also some alarms, actions and event handlers to work. They can all be
created by clicking the button “Create alarms, actions and event handler for Cold Chain Temp. option”. After clicking
the button, the Configurator shows a list of created items.

After creating all the needed items with the button, it is still recommended to check that the parameters for each
alarm, action and event handler are correct and for example the address for sending the temperature information is
correct.

Note! When Cold Chain Temperature SW option is used, other features using the command listener port cannot be
used,  for  example  the  Garmin  interface.  The  Cold  Chain  Temperature  SW  option  overrides  the  Command
listener/debug interface settings and uses the port set in Command listener/debug interface page.

For further information about the Cold Chain Temperature SW option, see the application note K505034 Cold Chain
Temperature SW Option.
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7.9 WLAN (only A11W device)

The WLAN tab has the parameters for configuring the WLAN feature. Limited access point mode parameters are
shown in the picture below.

See the K530100 A11 SW User Manual for more information about configuring the WLAN feature.
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7.10 BLE (only A11 devices with BLE HW)

The BLE tab has the parameters for configuring the BLE feature. Beacon scan mode parameters are shown in the
picture below.

See  the  documents  K530100 A11  SW  User  Manual  and  K505047  A11  BLE  use  application  note  for  more
information about configuring the BLE feature.
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8 XML EDITOR

Select  File ->  New <A-series device> configuration (XML) or  File ->  New <A-series device>
configuration (XML)  to start  building a new configuration using the XML editor.  The XML editor can be
opened also using the Create (XML) and Edit selected (XML) buttons on the Configuration list tab.

When the XML editor is opened for a new configuration, the Configurator opens a template configuration that has
default  values  for  all  the required  settings.  The  template  is  provided as  a  convenience  to  help  creating  new
configurations using XML editor.

The  XML editor  allows  editing  of  the  raw A-series  SW  XML configuration  file  and  it’s  targeted  at  the  more
experienced users of A-series SW. See corresponding A-series device’s  SW User Manual  for more information
about A-series SW configuration.

In  the Configurator, each configuration is identified by its name and version number. The name and version of a
configuration are stored in the root tag of the XML configuration file. Change the name and/or version attributes of
the configuration’s root tag (configuration) and save the configuration to create a new configuration and leave the
old configuration intact.

Tip! The XML editor has undo/redo functionality. Keyboard shortcuts are Ctrl+Z (undo) and Ctrl+Y (redo).

8.1.1 Buttons

Validate

Validates the configuration and displays the validation result. See chapter 9 for more information about validation.

Save

Saves the configuration. The configuration is validated before saving.

67 (107)



Aplicom A-series SW Configurator User Manual             Confidential 
K530800 rev. 13.2.0         
Save and Close

Saves the configuration and closes the XML editor. The configuration is validated before saving.

Close without saving

Closes the XML editor without saving the configuration.

68 (107)



Confidential     Aplicom A-series SW Configurator User Manual
     K530800 rev. 13.2.0

9 CONFIGURATION VALIDATOR 

The Configurator validates all configurations while saving the configuration and before starting an update. First, the
validator checks that the configuration file is a well-formed XML document. Then the validator checks that

• the configuration contains all required elements.
• the configuration does not contain any unsupported elements.
• the values are valid and within range.

If the validation fails, the Configurator displays the found errors and warnings. The Configurator classifies the found
problems  into  three  categories,  fatal  errors,  errors  and  warnings.  An  error  or  fatal  error  indicates  that  the
configuration contains serious problems, which will prevent the device from using it. A warning indicates that the
configuration is usable, but the configuration may not work as intended.

Note! Even though the Configurator validates the configurations, it  is  possible to create a configuration, which
passes the validation but causes performance and out-of-memory problems. It  is therefore the responsibility of
configuration designers to make sure the configuration works as intended. Always test configuration very carefully
before deployment. The configuration should be tested under highest expected load to ensure correct functionality
in all circumstances.

9.1 Fatal error

A fatal error means that the configuration file is not a well-formed XML document. The error report contains a line
number and description of the error. The Configurator does not allow continuing the operation if a fatal error is
found. If the error was found while saving the configuration, the Configurator does not save the configuration and
returns to the editor. If the error was found during update, the update is cancelled.

9.2 Errors, warnings and notes

An error means that the configuration file is missing important elements, contains unsupported elements, or has
invalid values. In other words, the configuration file is not a valid A-series SW configuration. 

A warning means that the configuration file is a valid A-series SW configuration, but it has some potential problems.
The configuration may not work as intended.

If any error or warnings were found, the Configurator displays a list of found errors and warnings.

If an error or a warning is found while validating the configuration from XML editor, double-clicking a message in the
list will highlight the source of that problem in the editor.
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If an error or a warning is found while saving the configuration, the Configurator will ask for confirmation before
saving the configuration.
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10 DEVICE MANAGEMENT

The  Device list tab contains a list  of  available devices and provides functionality to add, edit and remove
devices. When the Configurator is started for the first time the device list will contain one example device. 

10.1 Device list

All known devices are displayed in the device list. The following information is stored about each device.

Field Description
Name Name or  alias  for  the device.  This  could  be,  for  example,  the license plate

number of the vehicle where this device is installed.

IMEI IMEI  code  of  the device.  Configurator  uses  the IMEI  code  to  recognise  the
devices. Two devices are not allowed to have the same IMEI.

Phone number Phone number of the SIM card in this device. This phone number is used to
send SMS messages to the device. The phone number must be in international
format,  starting  with  a  plus  sign  (+),  for  example  +358012345678.  The
international format beginning with ‘00’ is not accepted.

Configuration in use The configuration that was last updated to the device using the Configurator.
The Configurator assumes that the device is currently using this configuration.
This field is updated automatically on successful update.

Latest update Latest  update.  Date  and  time  of  the  latest  successful  update.  This  field  is
updated automatically on successful update.

SW version SW version. Version number of the SW that is currently used by the device. This
field is updated automatically.

Status Status of the device. This field is updated automatically.

Description Description of the device. This field can be used to further describe the device or
it’s installation location.
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10.2 Adding a new device

Click the Add New Device button to add a new device to the list. A new template device will be added to the list.
The new device will become selected and it can be edited just like any other device in the list. 

10.3 Editing a device

To edit a device, select it from the list and double click on a field to change its value. 

10.4 Removing devices

Select the devices to remove by checking the checkbox at the beginning of the device line. Click the  Remove
Selected Devices button to remove the selected devices from the device list. 

10.5 Searching devices

The device list has a search bar that can be used to search for devices by one or more field. Type search terms in
the fields of the search bar and press Enter to search devices. The device list display will be limited to devices that
match the entered search terms. Click the X button in top-left corner of the device list to clear all search terms and
reset the device list display to all available devices.
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11 LOCAL UPDATE

To update a device configuration locally, the device must be powered on and connected to the computer using a
serial data cable for A-series device or standard micro USB cable when using an  A-series device with USB. A
correct PC serial port must be selected in Configurator Options. 

When using USB, select one of the following USB interface’s virtual COM ports:

With 3G devices (A11, A9 TRIX): 
Nameless Cinterion EhxUSB Modem port or one of Cinterion Ehx USB Com Ports 3 – 5.  Note! Ports 1 and 2
cannot be used.

With 4G devices (A11 LTE, A9 PRO):
Nameless Cinterion ELSx USB Modem port or one of Cinterion ELSx USB Com Port 2. Note! Ports 1 and 3 cannot
be used.

See chapter 14 for more information about Configurator Options.

11.1 Installing configuration to A-series

Select a configuration from the drop-down box in the Local Update section.

Click the Update Local button to start the update. During the installation procedure the Configurator

• Creates a new SW archive (JAR file), and copies the selected configuration into the new archive.
• Connects to A-series device and installs the created SW archive.
• Resets the A-series device to activate the installed software and configuration.

After the update is completed, the Configurator updates the device list to reflect the updated device status. If the
updated device is not found in the device list, the Configurator asks if the updated device should be added to the
device list.

Note! The Configurator automatically sets the correct auto-start application during the update. However, the Java
application auto-start is not turned on during the update if it was turned off before.

Note! Any old configurations and their backups are deleted from the device during the local update.

11.2 Installing multiple configuration at once

Multiple configurations can be selected by clicking the(...) button in the Local Update section. The Select
configurations window will be displayed.
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A default  configuration and zero or more additional configuration can be selected. The default  configuration is
installed as described in chapter 11.1. The additional configurations are also included in the installed SW archive as
separate files.

The additional configurations are stored with file names that follow the scheme:

<name>-<version><extension>

For example, configuration file containing AplicomDrivingBasix version 1.0 would be stored in the SW archive
as AplicomDrivingBasix-1.0.xml. The <extension> is always .xml.

11.3 Updating A-series SW when COM1 is in use

If the USB interface is not used, the Configurator communicates with A-series SW via the COM1 port of the device. 

If  the  COM1  interface  is  reserved  for  other  use  (such  as  Garmin  interface),  the  Configurator  is  unable  to
communicate with it. The COM1 interface is, however, always available for few seconds after a reset or power on.

Reset the device while the Configurator is making connection to the device, that is, click Local Update and reset 
A-series device within 5 seconds. Use the reset switch to reset the device. With A9 devices, the reset button is 
under the cover. The button is located next to the SIM card holder on the PCB. 

Note! Please make sure that proper ESD protection is used before opening the cover of the device. 
Note! With A11 and A9 PRO, prefer using USB port for SW updating.

11.4 Deleting data from A-series device

Software, configurations and all data (logs, stored messages, etc.) can be deleted from A-series device locally.
Select Tools -> Delete data from <A-series device>... to open the Delete data from <A-series
device> window.

Select directories to delete by checking the check boxes and click Delete data to connect to A-series device and
delete the selected directories from A-series device flash file system.

If  the  Delete everything (format) check box is selected, then the Configurator will  format the A-series
device flash file system, erasing all files and directories.

Check the Use USB check box when using a device with USB cable.
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11.5 Troubleshooting

If the Configurator fails to establish a connection to the device during local update:

• Check that the A-series device is powered on and operating normally. During normal operation A-
series LED A or LED E or F is lit.

• Check cables. A data cable (D337055 for A9 NEX/TRIX devices and Micro-USB for A11 and A9 PRO 
devices) must be used.

• Check ports. The cable must be connected to COM1 on A-series device. A correct PC serial port must 
be selected in Configurator Options. See chapter 14 for more information about Configurator Options.

• Close any other applications that might be using the selected COM port, such as a terminal program.
• Reset the device while the Configurator is making connection to the device, that is, click Local 
Update and reset A-series device within 5 seconds. Use the reset switch to reset the device. With A9 
devices, the reset button is under the cover. The button is located next to the SIM card holder on the 
PCB. 
Note! Please make sure that proper ESD protection is used before opening the cover of the device. 

• Some USB-RS232 adapters are known to not work with Module Exchange Suite (MES), which is used 
by the Configurator for local updates. The following USB-RS232 adapters are known to be compatible 
with MES:

• FTDI US232R-100
• FTDI UC232R-10
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12 OTAP UPDATE

The Configurator supports updating A-series SW and its configuration using Over-The-Air Provisioning (OTAP).
Using OTAP updates requires a GSM modem for sending OTAP SMS messages and an OTAP server to host files
and receive OTAP update notifications from A-series devices. See appendix A for information about using A-series
device as a modem. See appendix B for information about the OTAP server.

12.1 Setting up the Configurator for OTAP

Some options must  be configured  before OTAP update features  of  the Configurator  can be used.  Open the
Options window by selecting  Tools ->  Options from the main menu to set required options for using OTAP
updates.

Normally it  is  enough to enter an  OTAP server configuration URL on the  OTAP Server tab. If  OTAP
server configuration URL is set, the Configurator downloads OTAP server configuration file from the server.
The  settings  downloaded  from  the  server  can  be  overridden  locally  by  setting  them  in  the  Configurator
Options. See chapter 14 for more information about the Configurator Options window.

If the OTAP server does not provide an OTAP configuration file or it’s missing some options, the missing options
must be set locally in Configurator Options.

The options that are required for different tasks are listed in Table 1. All of these options can be specified in the
OTAP server configuration file unless noted otherwise.

Task Required options

Automatically synchronize 
device list with OTAP server.

OTAP Server tab
OTAP status URL

Enable OTAP for A-series 
devices with OTAP SMS 
password.

OTAP SMS tab
Password for OTAP authentication

Enable A-series devices to 
report OTAP status.

OTAP Server tab
OTAP server HTTP authentication (must be set locally if the server 

requires HTTP authentication) 
• User name
• Password

OTAP notification URLs
• Install
• Delete

OTAP SMS tab
GPRS Access Point Name (APN)
GPRS network authentication

• User name
• Password

Enable A-series devices to 
download files from OTAP 
server.

OTAP Server tab
OTAP server HTTP authentication (must be set locally if the server 

requires HTTP authentication) 
• User name
• Password

Server data download URL

OTAP SMS tab
GPRS Access Point Name (APN)
GPRS network authentication

• User name
• Password
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To transfer files to OTAP 
server via HTTP using the 
Configurator.

File Transfer tab
OTAP server HTTP authentication (must be set locally if the server 

requires HTTP authentication) 
• User name
• Password

HTTP file transfer settings
• HTTP upload URL
• Password for HTTP uploads (must be set locally if the 

server requires HTTP upload password)

To transfer files to OTAP 
server via SFTP using the 
Configurator.

File Transfer tab
SFTP file transfer settings

• Address
• Port (optional, default is 22)
• Data directory

Table 1. Required options for different tasks.

12.2 Updating A-series device using OTAP

• Select the devices for update by marking their check boxes in the device list. Each selected device 
should have an IMEI and a phone number set, otherwise the device can’t be updated using OTAP.

• Select a configuration from the drop-down box in the OTAP Update section.
• Click the Update selected OTAP button to begin the OTAP update procedure.

The Configurator builds a custom version of A-series SW that contains the selected configuration, and uploads it to
the OTAP server. Next, the Configurator creates and sends OTAP update SMS messages to each selected device.
The messages contain GPRS network settings and information about where the updated A-series SW  can be
downloaded. The parameters are distributed over several  SMS messages if  they do not fit  into one message.
Typically two messages are required to start OTAP update.

Note! OTAP update does not delete stored messages or any old XML configuration files that have been installed
manually without the Configurator or using the OTA configuration. See K503051 A-series Telematics SW Config
OTA Update Manual for more information about OTA configuration feature. If such XML configuration file exists on
the device, the existing configuration will be used instead of the configuration updated using OTAP. In this case,
delete the A-series SW and all configurations from the device before starting OTAP update. The A-series SW, its
XML configuration files and stored messages can be deleted using OTAP. See chapter 12.3 for more information
about the OTAP delete functionality.
 
After A-series device receives the OTAP update SMS messages, it stops the normal operation and enters OTAP
mode. See corresponding A-series device’s SW User Manual for more information about the OTAP mode. In OTAP
mode, A-series reads the received OTAP update SMS messages and starts to download the updates from the
OTAP server using a GPRS connection and HTTP. After the device completes the download, it sends a notification
message to the OTAP server and resets itself. The device starts normal operation using the updated configuration
after the reset.

The Configurator  monitors  the OTAP server  log and detects  notifications about successfully completed OTAP
procedures. The Configurator updates the status of a device to “Updated” in the device list as soon as a notification
is detected.

Note! Due to nature of  the GSM network and SMS delivery, it  cannot be guaranteed that the A-series device
receives the sent SMS messages. If the target device is not registered to GSM network, the SMS delivery can take
a very long time. The Configurator sets the validity period of all sent SMS messages to 24 hours. This means that
the SMS message is discarded if it cannot be delivered within 24 hours.

Note! Length of an SMS is limited to 140 characters when using 8-bit character encoding. Therefore length of the
JAD download URL sent to A-series device when starting OTAP update can be at most 121 characters. This should
be considered when selecting a name for configurations. If OTAP password is used, the maximum length is further
reduced because the OTAP password must be included in each OTAP SMS.
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Figure 2. OTAP update procedure.
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12.3 Deleting A-series SW and its configuration from A-series device using OTAP

• Select the devices by marking their check boxes in the device list. Each selected device should have 
an IMEI and a phone number set, otherwise OTAP delete can’t be used with the device.

• Select Tools -> Delete <select A-series device> SW (OTAP) from the main menu to begin
the OTAP delete procedure.

The Configurator creates and sends OTAP delete SMS messages to each selected device. The message contains
instructions to delete the A-series SW and its configuration from the A-series device. The messages also contain
GPRS network  settings,  which enables the A-series  device to send a status report  to  the OTAP server.  The
parameters  are distributed over  several  SMS messages if  they do not  fit  into  one message.  The parameters
required to start OTAP delete typically fit in one SMS message.

Once an A-series device receives the OTAP delete SMS message, it stops the normal operation and deletes the A-
series SW and its configuration that are stored in the device’s flash file system. After the device has deleted the A-
series SW and its configuration, it sends a notification message to the OTAP server and resets itself. The device
will remain powered on after the reset. Because the A-series SW was deleted, the device will not do anything useful
until the next successful update.

The OTAP delete needs also the JAD URL parameter for the SW to be deleted. To find that out, the procedur
includes an additional SMS sent to the device and a response SMS from the device. See the diagram below.

If  the target  device can not send the response SMS, for  example if  the SIM card is not allowed to send text
messages, the JAD URL needed for the delete can be set in the OTAP SMS tab in the A-series SW Configurator's
Options. 

Figure 3. OTAP delete procedure.

12.4 Copying configuration and software to OTAP server

Select a configuration from the drop-down box in the OTAP Update section of the main Configurator screen. Click
the Copy to OTAP Server button to start copying files to OTAP server.

The Configurator builds a custom version of A-series SW that contains the selected configuration and uploads it to
the OTAP server.
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13 USING CONFIGURATOR WITH CUSTOM SOFTWARE

The Configurator supports management of A-series devices with custom software (other than A-series SW). The
Device list tab is used for custom device management. See chapter  10 for more information about device
management.

The Configurator installs custom software to a:/bin directory of A-series device flash file system by default. The
custom SW installation directory can be changed by editing or adding property Storage.Custom.AppDir in the
properties.xml file.  See  chapter  3.1 for  more  information  about  the  data  and  configuration  files  of  the
Configurator.

13.1 Local Update

Click the Update Local button to update a locally connected device. The Configurator will update the device with
the  custom  SW  that  was  previously  selected  using  Tools ->  Select custom SW for updates.  The
Configurator will  display the  Select custom SW window, if  custom SW  has not been selected already. See
chapter 3.2.3 for more information about selecting custom SW for updates.

Note! Check the Use USB check box when using the device with USB.

The Configurator installs the selected custom SW to the device just like it would do with A-series SW. See chapter
11 for more information about the local update.

13.2 OTAP Update

Select the devices for update by marking their check boxes in the device list. Each selected device should have an
IMEI and a phone number set, otherwise the device can’t be updated using OTAP. Click the Update selected
OTAP button to update selected devices using OTAP.

The Configurator will update the device with the custom SW that was previously selected using Tools -> Select
custom SW for updates. The Configurator will display the Select custom SW window, if custom SW has not
been selected already. See chapter 3.2.3 for more information about selecting custom SW for updates.

The Configurator updates the selected devices just like it would do with A-series SW. See chapter  12 for more
information about the OTAP update.
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Note! OTAP update changes the Java  application  autostart  settings  to  start  the installed  application.  If  Java
application auto-start is disabled on the target device, it is not enabled by OTAP.

13.3 OTAP Delete

Only one device at a time can be selected for Custom SW OTAP delete. Select the device by marking it's check
box in the device list. The selected device should have an IMEI and a phone number set. Select Tools -> Delete
Custom SW (OTAP) from the Configurator main menu to delete a custom SW from the A-series device.

The Configurator creates and sends OTAP delete SMS messages to the selected device. The message contains
instructions to delete the SW and its installation directory from the A-series device. The messages also contain
GPRS network  settings,  which enables the A-series  device to send a status report  to  the OTAP server.  The
parameters  are distributed over  several  SMS messages if  they do not  fit  into  one message.  The parameters
required to start OTAP delete typically fit in one SMS message.

Note! The OTAP delete procedure needs also the JAD URL parameter to be performed. The URL should be the
exact path to the directory where the application is installed from. For example, if the application is installed by
locally uploading it to the module, the path points to the modules Flash drive and could look like this:

a:/bin/D111111-CUSTOM-SW.jad

If the application is installed from a server via OTAP the path points to the OTAP server. For example:

http://111.11.11.111:1234/A1OtapServer/download?file=/1104586719/D111111-CUSTOM-SW.jad

See chapter 12.3 for more information about the OTAP delete functionality.
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14 CONFIGURATOR OPTIONS

Select Tools -> Options from the Configurator main menu to open the Options window.

14.1 General

The General tab is used to configure communications ports and modems used by the Configurator.

COM port for local updates

Name of the COM port used for local updates.

COM port for GSM modem

Name of the COM port used by the GSM modem.

Device system out routing after local update

Selects which interface is used to output device’s system out prints. Applies only with local update.

Device log level after local update

Selects which log level is used for device’s logging. Applies only with local update.

Use secure command for log level 1

Selects if a secure command is to be used when setting log level to most verbose (1, trace). Only some old SW
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versions do not support this. Applies only with local update.

Disable autostart after local update

Selects if a the automatic starting of the application is disabled after local update. Normally the autostart should be
enabled.

SMS service center number

This number is used as SMS service center when sending SMS messages. If SMS service center number is not set
the service center number stored on SIM card is used.

User interface Look and Feel

Selects the Look and Feel of the Configurator’s user interface. The list of available Look and Feels depends on
system configuration. Default Look and Feel is Metal.

Configurator data directory location

Selects  where the Configurator  stores  it's  data files.  Starting with  Configurator  version 5.0.0,  the default  data
directory location is in user's application data directory for all new installations. Upgrade from previous version
keeps the data directory location intact.

Note! Configurator does not automatically move or copy files from old data directory to new data direcotory when
changing the data directory location. To transfer the old data to new location, close the configurator and copy data
manually.
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14.2 OTAP Server

The OTAP Server tab defines the URLs required by the Configurator for communicating with the OTAP Server.

Typically, only the OTAP server configuration URL is required. Configurator will fetch all other settings from
the this URL.

OTAP server HTTP authentication

The  user  name and password  for  HTTP authentication required  for  communicating the OTAP server.  These
parameters must be set, if the OTAP server is configured to use HTTP authentication.

OTAP server configuration URL

If OTAP server configuration URL is set, the Configurator downloads OTAP settings from the server using
this URL.

Note! If the OTAP server configuration URL is defined and OTAP settings are available on the server, the
remaining URLs on this page can be left empty. The values set on this page override the values downloaded from
the server.

OTAP status URL

URL to OTAP server’s device status page. The Configurator uses the OTAP status URL to synchronise the device
list with OTAP server’s device status data. 

OTAP server log URL

URL to OTAP server’s log page.
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OTAP server data download URL

The Configurator uses Data download URL to build URLs for downloading data files from the OTAP server. The
Configurator appends a forward slash (‘/’) and a file name to data download URL. The built data download URLs
are used in OTAP SMS messages to tell A-series device where to download the updated A-series SW.

OTAP notification URLs

Install  and delete  notification URLs for  OTAP.  The A-series  device will  report  successful  OTAP configuration
updates and deletes to these URLs.

Type of file path for OTAP

Selects which file path type the Configurator uses for OTAP. Old type uses configuration name and version as the
directory name and the default type uses the hash code of the configuration name and version as the directory
name. 

For example, the old type: http://81.61.111.111:1111/otap/download?file=/A9%20Starterkit%20Config-1.0/D205101-
A9-NEX-SW.jad  and  the  default  type:  http://81.61.111.111:1111/otap/download?file=/-1333040117/D205101-A9-
NEX-SW.jad.

A-series SW Configurator version 10.32.0 and newer and Aplicom OTAP server version 5.1.3 and newer use the
new default type of the file path.

The A-series SW Configurator and Aplicom OTAP server are compatible as follows:
• A-series SW Configurator versions older than 10.32.0 are fully compatible with old and new Aplicom OTAP

Server.
• A-series SW Configurator version 10.32.0 is fully compatible with the Aplicom OTAP Server version 5.1.3

and newer. With Aplicom OTAP Server older than version 5.1.3 the OTAP update works normally but the
configuration file names are not showed correctly in Update Query configuration.

• A-series SW Configurator version 10.32.2 and newer is fully compatible with the Aplicom OTAP Server
version 5.1.3 and newer. Full compatibility with Aplicom OTAP Server older than version 5.1.3 is achieved
when type of file path is selected to be “Old type”. If the selected path type is “Default” the OTAP update
works normally but the configuration file names are not showed correctly in Update Query configuration.

14.3 File Transfer

The File Transfer tab is used to define how the Configurator copies the files to the OTAP server.

Note! If OTAP server configuration URL is set on the OTAP Server tab, the Configurator downloads OTAP
settings from the server. If the OTAP settings are available on the server, all options (except the password for HTTP
file transfers) on this page can be left empty. The values set on this page override the values downloaded from the
server.
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File transfer method

Defines the method that the Configurator uses to transfer files to OTAP server while preparing to start an OTAP
update operation. Currently supported file transfer methods are HTTP and SFTP (Secure File Transfer Protocol).
The default is HTTP. The OTAP server supports HTTP file transfers. SFTP requires additional software on the
server to work correctly.

HTTP file transfer settings

Upload URL is the URL to OTAP server’s upload page. The Configurator sends file transfer requests to this URL
when preparing for OTAP update.

Password is the password used for authenticating HTTP file transfers. The option must be set, if the OTAP server
is configured to require a password for HTTP uploads. Leave this field empty, if  the server does not require a
password for HTTP file transfers.

SFTP file transfer settings

Address is the IP address or host name of the OTAP server.

Port is the port number used by the SFTP service on the OTAP server.

Data directory is full path to configuration data directory on the web server. The configuration files used for
OTAP will be copied to this directory. Example: /var/www/a1otap/data.

14.4 OTAP SMS

The options on OTAP SMS tab define the settings sent to A-series devices in the OTAP update and delete SMS
messages.

Note! If OTAP server configuration URL is set on the OTAP Server tab, the Configurator downloads OTAP
settings from the server. If the OTAP settings are available on the server, options on this page can be left empty.
The values set on this page override the values downloaded from the server.
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Password for OTAP SMS authentication

Password for authenticating OTAP SMS messages.

Custom OTAP passwor

If custom password is selected in the "Password for OTAP SMS authentication" selection, the password is set here.

GPRS Access Point Name (APN)

GPRS Access Point Name (APN) for connecting to internet during OTAP.

GPRS network authentication

User name and password for authenticating with the network.

DNS server address

Domain Name Server’s IP address used by A-series device to query hostnames during OTAP.

Pre-set JAD URL for OTAP delete

If the target device cannot send SMS messages so that the JAD URL of the SW could be found out, the JAD URL
can be set here. See chapter 12.3 for more information about the OTAP delete functionality.
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14.5 Sections

The Sections tab is used to define which Configurator sections are displayed.

Selected sections are displayed in the tab bar at the left side of the Configurator window.

Custom SW application directory

Selects the directory at device flash for the custom SW. The default is a:/bin

Note! All changes on the Section page take effect after the Configurator is restarted.
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15 A-SERIES SOFTWARE MANAGER

Select Tools -> Manage device SW... from the Configurator main menu to open the A-series software
manager window. This window is used to manage the applications on the A-series device.

The A-series software manager  window uses the serial port specified in the Options window as COM port
for local updates. See chapter 14.1 for more information about selecting the PC serial port.

Input
The value set in the field is used when making the following actions:

• stop selected
• uninstall selected
• install selected
• start selected

The value is expected to be a valid JAD URL.

Output
The value is the output of the following actions:

• read installed
• read running

The value or parts of the value can be used as input to the other actions.

Set sysout
Selects the interface which is used to ouput the device's system out prints.

Read installed
Reads the installed applications on the device. The result is printed to the output field.
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Read running
Reads the running applications on the device. The result is printed to the output field.

Stop selected
Stops the selected application. The application is selected by inserting the JAD URL of the application to the input
field.

Stop all
Stops all applications (except the built-in JRC and SLAE applications) from the device.

Uninstall selected
Uninstalls the selected application. The application is selected by inserting the JAD URL of the application to the
input field.

Uninstall all
Uninstalls all applications (except the built-in JRC and SLAE applications) from the device.

Install selected
Installs the selected application. The application is selected by inserting the JAD URL of the application to the input
field.

Start selected
Starts the selected application. The application is selected by inserting the JAD URL of the application to the input
field.

Autostart on
Sets the automatic starting of the applications enabled. The change is effective at next startup.

Autostart off
Sets the automatic starting of the applications disabled. The change is effective at next startup.

Close
Closes the window.
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16 APPENDIX A: USING A-SERIES DEVICE AS A GSM MODEM

To use A-series device as a GSM modem for sending SMS messages:

• Insert a SIM card to A-series device.
• Connect GSM/GPRS antenna to GPRS connector of the device (A9 devices have internal GSM/GPRS 

antenna).
• Connect a data cable (Micro-USB for A11 and A9 PRO and D337055 for A9 TRIX/NEX) between PC 

and port COM1 or USB of the A-series device.
• Power on the A-series device.
• Set the autostart setting of the device off.

For setting the autostart setting off, the A-series software manager can be used (see chapter 15. A-series software
manager) or use the instructions below:

Open a serial connection to A-series device using a terminal program (connection settings: 115200bps, 8N1, no
flow control). Enter the following AT command to disable auto-start feature of A-series device. A-series device can’t
be used as a modem while a Java application is running on the A-series device.

AT^SCFG="Userware/Autostart","","0"

Restart the A-series device to activate the autostart setting.

AT^SMSO

The A-series device will restart and print the following:

^SYSSTART

Enter the following AT command to check that the AT interface is active (response should be “OK”):

AT

Disconnect the terminal program’s connection to the port.

16.1 Restoring normal operation mode

Enter the following AT command to enable the autostart again:

AT^SCFG="Userware/Autostart","","1"

Restart the A-series device to activate the autostart setting.  Disconnect the terminal program’s connection to the
port.
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17 APPENDIX B: SETTING UP AN OTAP SERVER

The A1 OTAP server web application provided with SW Package for A-series or it is loadable from Aplicom extranet
(www.aplicom.com/en/extranet) consist of a set of Java Servlets that can be used with Apache Tomcat 8.

17.1 Server requirements

A1 OTAP server web application requires a server that meets the following requirements:

• Java SE Runtime Environment version 1.8 or newer
• Apache Tomcat version 8.0.

See Java and Apache Tomcat Documentation for installation instructions for Java SE Runtime Environment and
Apache Tomcat.

17.2 Installing the A1 OTAP server

Please see the installation instructions from the OTAP server’s Quick Start - read me.txt file.

17.3 A1 OTAP server configuration

The current A1 OTAP server configuration can be viewed and modified using A1 OTAP server’s setup page. URL to
the setup page is formed by appending /setup to A1 OTAP server’s base URL, for example:

http://localhost:8080/A1OtapServer/setup

Open the A1 OTAP server  setup page in a web browser and log in. The default password in a new A1 OTAP
server installation is A1SwConfigurator.

Once logged in, the configuration page is displayed. It is recommended to change the passwords immediately.
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17.3.1 Configuration parameters

The available configuration parameters are described below. The A1 OTAP server detects and sets some settings
automatically. The parameter values specified on the setup page override the automatically detected values. The
current configuration, with automatically detected parameters, is displayed at the bottom of the setup page.

OTAP server log URL (Comm.OTAP.LogURL)

URL to the log page on the OTAP server. A1 OTAP server sets this property automatically.

OTAP server data download URL (Comm.OTAP.DataURL)

URL to where configuration and software updates can be downloaded. The Configurator appends the file name’s
hash to this URL.  A1 OTAP server sets this property automatically.

OTAP server configuration URL (Comm.OTAP.ConfigURL)

URL to OTAP server configuration file. The Configurator reads the server configuration file from this URL. A1 OTAP
server sets this property automatically.

OTAP server status URL (Comm.OTAP.StatusURL)

URL to OTAP server status page. The status page contains status information, such as status of OTAP operation
for each known device. A1 OTAP server sets this property automatically.

OTAP install notification URL (Comm.OTAP.InstallNotify)

URL of page that handles the OTAP install notification messages. The A-series devices post status information
during OTAP install operation to this URL. A1 OTAP server sets this property automatically.

OTAP delete notification URL (Comm.OTAP.DeleteNotify)

URL of page that handles the OTAP delete notification messages. The A-series devices post status information
during OTAP delete operation to this URL. A1 OTAP server sets this property automatically.

Method for file transfers (Comm.FileTransfer.Method)

Defines the method that the Configurator uses to transfer files to OTAP server while preparing to start an OTAP
update operation. Currently supported file transfer methods are HTTP and SFTP (Secure File Transfer Protocol).
The  A1 OTAP server  supports  HTTP file  transfers.  SFTP requires  additional software  on the server  to  work
correctly. If this property is not set, A1 OTAP server sets this property automatically to HTTP.

OTAP server HTTP upload URL (Comm.OTAP.UploadURL)

URL to OTAP server upload page. The upload page handles HTTP file uploads. The Configurator sends file upload
requests to this address while preparing to start an OTAP update operation. A1 OTAP server sets this property
automatically.

SFTP server address (Comm.SFTP.Address)

Address of the SFTP server, which should be connected by the Configurator to transfer data files.

SFTP server port number (Comm.SFTP.Port)

Port number of the SFTP server, which should be connected by the Configurator to transfer data files.

SFTP server data directory (Comm.SFTP.DataDir)

Path to data directory on the SFTP server. This is where the Configurator uploads files that are used for updating
configuration and software of A-series devices.

OTAP SMS password (Comm.OTAP.Password)
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Password for authenticating OTAP messages on A-series device. If OTAP password is enabled on the target A-
series device, each OTAP SMS short message must contain the selected password. A-series device will ignore all
OTAP messages that do not contain a valid password. 

Note! It’s not recommended to store the OTAP SMS password on the server because it is stored as plain text and
is readable to anyone who has access to the config or setup page of the A1 OTAP server.

GPRS Access Point Name (Comm.OTAP.APN)

GPRS Access Point Name (APN) for OTAP. A-series devices use access point when opening network connections
during OTAP.

User name for GPRS authentication (Comm.OTAP.NetworkUser)

User name to use for GPRS network authentication. A-series devices use this user name when opening network
connections during OTAP.

Password for GPRS authentication (Comm.OTAP.NetworkPassword)

Password to use for GPRS network authentication. A-series devices use this password when opening network
connections during OTAP.

DNS server address (Comm.OTAP.DNS)

Address of DNS server for OTAP. A-series devices use this server to resolve domain names when downloading
files during OTAP.

17.3.2 OTAP server passwords

The A1 OTAP server has two different passwords; one for server administration and one for HTTP uploads.

Note! Only a SHA-512 hash of these passwords is stored in the OTAP server configuration file. This means that it is
very difficult to recover a lost password. To reset a lost password, edit the OTAP server configuration file by hand
and remove the Server.Admin.Password property. Then log on to the setup page with an empty password and
set a new OTAP server administration password.

Password for HTTP file upload (Comm.OTAP.UploadPassword)

Password used to authenticate HTTP file upload requests on the OTAP server. The default password in a new A1
OTAP server installation is A1SwConfigurator.

OTAP server administration password (Server.Admin.Password)

Administration password for the A1 OTAP server. This password is required when accessing the setup page of A1
OTAP server. The default password in a new A1 OTAP server installation is A1SwConfigurator.
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17.4 OTA Config update support in A1 OTAP server

A1 OTAP Server supports OTA Config update (or update query) mechanism since version 4.0.0. See the document
K503051 A-series Telematics SW Config OTA Update Manual and UPDATE_QUERY action in  the device’s  SW
User Manual for more information about the OTA Config update.

The OTA config update support in A1 OTAP server is based on the concept of matching an incoming update query
against a set of pre-define update rules. An update query contains A-series device IMEI and information about
currently active software and configuration. An update rule consists of a filter for each update query parameter and
a name of output configuration.

When an update query is received, A1 OTAP Server attempts to match the update query to each defined update
rule. An update rule matches the update query if all update query parameters pass the filters of an update rule. If a
matching rule is found, the OTAP Server responds to the update query by sending the output configuration of that
rule. If none of the rules match the update query, the OTAP server sends a 'update not available' response.

Figure 4. Determining update query response.
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17.4.1 Update query setup page

The update rules are configured using the A1 OTAP Server's update query setup page. URL to the update query
setup page is formed by appending /setup/updatequery to A1 OTAP server’s base URL, for example:

http://localhost:8080/A1OtapServer/setup/updatequery
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17.4.2 Update rules for update query

Update rules are used to determine which configuration should be sent out when an update query is received from
A-series device. An update query contains A-series device IMEI and information about currently active software and
configuration.  An  update  rule  consists  of  a  filter  for  each  update  query  parameter  and  a  name  of  output
configuration.

Update rule filters are case sensitive and they accept an asterisk (*) as a wild card character. A wild card matches
a sequence of zero or more any characters. For example, update rule filter Example*Config will match any update
query parameter that starts with Example and ends with Config. If asterisk character is not used in update rule filter,
exact match is required.

The update rule list displays all defined update rules and tools for creating new rules and modifying existing rules.

Click Create new rule to add a new rule. Enter parameters for the update rule and click Save. Click Discard
to close the update rule editor without creating a new rule.

There is a row of buttons at the end of each row of the update rule list. The buttons are explained below:

•  Edit an existing update rule. The update rule will be switched to editor mode. Modify parameters 

and click Save to accept changes. Click Discard to close the update rule editor without saving the 
changes.

•  Move an update rule up in the list.

•  Move an update rule down in the list.

•  Delete an update rule from the list.

17.4.3 Upload configuration

The Upload configuration section can be used to upload new configurations to A1 OTAP Server. Click the
Browse... button  to  select  a  configuration  file  from  your  computer  and  then  click  the  Upload  XML
configuration button to upload the selected configuration to A1 OTAP Server. The uploaded configuration will
become available in the new configuration drop-down box in update rules list.
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17.4.4 Test update rules

The  Test update rules section can be used to simulate an update query. Enter the parameters and click
Simulate update query button to send a simulated update query request.

A1 OTAP Server will process the simulated update query and display what it would do if it were an actual update
query.
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17.5 Example: setting up OTA configuration update

Preparing configuration for update query

1. Create a new configuration or open an existing configuration and add a Send update query action to it.
Enter URL of the A1 OTAP server's update page (for example http://www.example.com/a1/update) in the
Update URL field. Set the required GPRS access parameters provided by your operator.

2. Assign the  Send update query action to an event handler to enable the A-series device to query for
updates. Any event handler can be used depending on when the update query should be performed. For
example, Software start event handler can be used to check for configuration update each time the A-
series device starts up.

3. Install the configuration to A-series device using either local update or OTAP update.

At  this  point  the  configuration  is  normally in  use  for  a  period  of  time,  until  a  need to  modify or  replace  the
configuration arises.
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4. Create a new version of the configuration made in step 1 or create a completely new configuration to replace
the old configuration.

5. Upload the new configuration to A1 OTAP server by clicking Copy configuration to server button in
OTAP Update section of the Configurator's main screen. Alternatively, the configuration can be uploaded
using using A1 OTAP server's update query setup page.

6. Open the update query setup page of A1 OTAP Server and click Create new rule in the Update rules
for update query section to add a new update rule. The following example rule will match an update
query sent by any device with UpdateQueryExample-1.0 as current configuration. A device that sends a
matching update query will receive a new configuration UpdateQueryExample-2.0.

The A1 OTAP server is now set up to send the updated configuration when it receives an update query. If A -series
device is configured as described in steps 1 and 2, the configuration will be updated on next start up.
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18 APPENDIX C: OTAP SMS FORMAT

An OTAP SMS must use a Submit PDU with 8-bit  encoding, Class 1 and PID $7D. As a fallback for unusual
network infrastructures the SMS can also be of Class 0 and/or PID $00 with 8-bit encoding.

Note! Most mobile phones send SMS messages using 7-bit encoding to fit more characters in to one message
(160, as opposed to 140 with 8-bit encoding). 

18.1 OTAP SMS Content

The content of an OTAP SMS consists of a set of keywords and parameter values all encoded in ASCII format. The
OTAP SMS must contain one parameter per line. Each line (including the last one) must be terminated with a single
line feed (LF) character (0Ah). The parameters can be distributed over several SMS messages. If a parameter is
repeated in several SMS messages, the last sent value is used.

Each OTAP SMS must start with OTAP_IMPNG line. Otherwise it is not recognised as an OTAP SMS message and
will be ignored by the A-series device. If OTAP SMS password is used, it must be included in every OTAP SMS
message.

Last line of the last OTAP SMS message must contain a special  START parameter with value of  install or
delete.  The  START parameter initiates the OTAP procedure. Any parameters after the  START parameter are
ignored.

The following parameters can be set in an OTAP SMS.

Parameter Description Max. length Install operation Delete operation

JADURL JAD file URL 100 Mandatory Unused

APPDIR Application directory (on 
flash)

50 Mandatory Mandatory

HTTPUSER User name for HTTP 
authentication

32 Optional Unused

HTTPPWD Password for HTTP 
authentication

32 Optional Unused

BEARER Communication bearer - Mandatory Optional / POST

APNORNUM Access Point Name or 
number

65 Mandatory (GPRS) Optional / POST

NETUSER Network user name 32 Optional Optional / POST

NETPWD Network password 32 Optional Optional / POST

DNS Domain Name Server - Optional Optional / POST

NOTIFYURL Notify URL 100 Optional Optional / POST

PWD OTAP SMS password 32 Optional Optional

START Start OTAP procedure - Must be install Must be delete

Table 2. OTAP SMS parameters.

18.2 Example Install OTAP SMS

In this example the parameters do not fit within one SMS and are therefore sent in two messages. 

First SMS

OTAP_IMPNG
PWD:password
JADURL:http://www.example.com/app.jad
APPDIR:a:/work/appdir
HTTPUSER:httpuser
HTTPPWD:httppassword

Second SMS
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OTAP_IMPNG
PWD:password
BEARER:gprs
APNORNUM:apn
NETUSER:netuser
NETPWD:netpass
DNS:192.168.1.2
START:install

18.3 Example Delete OTAP SMS

In this example the parameters fit in one SMS. The GPRS parameters are required to enable the A-series device to
send notification messages to server.

OTAP_IMPNG
PWD:password
APPDIR:a:/work/appdir
BEARER:gprs
APNORNUM:apn
NETUSER:nuser
NETPWD:netpass
DNS:192.168.1.2
START:delete

A9 NEX/TRIX/IPEX and A11 example delete OTAP SMS messages. In this example the parameters don't fit in one
SMS and therefore two messages are needed. In both messages keyword OTAP_IMPNG and parameter PWD are
needed. Note! With A11 the SMS is similar but the application directory is not A9Sw/ but MainSw/.

Message 1: 

OTAP_IMPNG
PWD:0000
APPDIR:a:/A9Sw
JADURL:a:/A9Sw/D205101-A9-NEX-SW.jad
BEARER:gprs
APNORNUM:apn
NETUSER:nuser
NETPWD:netpass 

Message 2:

OTAP_IMPNG
PWD:0000
DNS:192.168.1.2
NOTIFYURL:http://123.45.67.89:1234/A1OtapServer/notify
START:delete
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REFERENCES

The following documents are found in Documents directory of SW Package for A-series or from Aplicom Extranet
(http://www.aplicom.com/en/extranet).

K503051 A-series Telematics SW Config OTA Update Manual
K503052 A-series SW COM1 Interface Command Reference Manual
K505038 1-Wire Temperature monitoring
K505034 Cold Chain Temperature SW Option
K505047 A11 BLE use

The following documents are found in Documents\Protocols directory of SW Packages for A-series devices.
S100300 Aplicom D Protocol Specification
S100304 Aplicom G Protocol Specification
S100301 Aplicom T Protocol Specification
S100340 Aplicom Reliable connection protocol Specification
S100320 Aplicom Garmin interface protocol
S100302 Aplicom F Protocol Specification
S100303 Aplicom E Protocol Specification
K505030 Fuel Alert SW Option

104 (107)



Confidential     Aplicom A-series SW Configurator User Manual
     K530800 rev. 13.2.0

ABBREVIATIONS AND DEFINITIONS

3PAD 3PAD is an A-series accessory with three buttons and LEDs. Pressing a button causes a state 
change in the box. This information can used for example to detect private / work driving.

AD Analog-to-Digital converter. An electronic circuit that converts continuous signals to discrete 
digital numbers.

AP An GPRS Access Point (AP) is:

An IP network to which a mobile device can be connected 

A set of settings which are used for that connection 

A particular option in a set of settings in a mobile phone 

When a GPRS mobile phone sets up a PDP context, the access point is selected. At this point 
an access point name (APN) is determined. Access point name could be, for example, 

Bigcompany.mnc012.mcc345.gprs. 

internet 

mywap. 

This access point is then used in a DNS query to a private DNS network. This process (called 
APN resolution) finally gives the IP address of the GGSN which should serve the access point. At
this point a PDP context can be activated.

API Application Programming Interface

APN Access Point Name, see “Access Point”

AT ATtention command language, part of Hayes Command Set.

Most dialup modems follow the Hayes Command Set to a large extent, originally developed for 
the Hayes Smartmodem 2400. The modem initialization string consists of a series of commands. 
It prepares the modem for communications, setting such features as dialing mode (tone or 
pulse), waits, detection of the busy signal and many other settings. Newer modem 
communications programs reset the initializations string for you according to which menu options 
selected or which features are enabled.

The Hayes Command Set can be divided into four groups:

Basic Command Set - A capital character followed by a digit. For example, M1. 

Extended Command Set - An “&” (ampersand) and a capital character followed by a digit. This is 
an extension of the basic command set. For example, &M1. Note that M1 is different from &M1. 

Proprietary Command Set - Usually started by either a backslash (“\”), or a percent sign (“%”), 
these commands vary widely among modem manufacturers. 

Register Commands - Sr=n where r is the number of the register to be changed, and n is the new
value that is assigned. 

A-GPS Assisted GPS is a system that often significantly improves startup performance (time-to-first-fix) 
of a GPS satellite-based positioning system.

BLE Bluetooth Low Energy is a wireless personal area network technology designed and marketed 
by the Bluetooth Special Interest Group.

CAN Control Area Network is a serial bus system, which was originally developed for automotive 
applications in the early 1980's. The CAN protocol was internationally standardized in 1993 as 
ISO 11898-1 and comprises the data link layer of the seven layer ISO/OSI reference model.

COM Common serial port interface in PC-computers.

DIN Digital input.

DLKP Driver Log Keypad is an A-series accessory with three buttons and LEDs. DLKP has been 
replaced by 3PAD.

DNS Domain Name System (DNS) is a system that stores information about host names and domain 
names in a kind of distributed database on networks, such as the Internet. Most importantly, it 
provides an IP address for each host name, and lists the mail exchange servers accepting e-mail 
for each domain.

DNS can also be used to look up the host name for an IP address. This procedure is called 
'reverse DNS look-up'.

EBS Electronic Braking System is the ability to control heavy duty commercial vehicle's brakes 
through electrical means.

FMS Fleet Management System (FMS) is standard for accessing truck data required by fleet 
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management systems using a manufacturer independent protocol. The FMS-interface is an 
optional interface of different truck manufacturers. Supported information is dependent upon 
vehicle equipment.

GPRS General Packet Radio Service (GPRS) is a radio technology for GSM networks that allows a 
mobile device (phone, PDA, etc) to connect to a network.

GPRS is packet-switched which means that multiple users share the same transmission channel,
only transmitting when they have data to send. This means that the total available bandwidth can 
be immediately dedicated to those users who are actually sending at any given moment, 
providing higher utilization where users only send or receive data intermittently. Web browsing, 
receiving e-mails as they arrive and instant messaging are examples of uses that require 
intermittent data transfers, which benefit from sharing the available bandwidth.

GPS Global Positioning System. Utilizing a constellation of at least 24 medium Earth orbit satellites 
that transmit precise radio signals, the system enables a GPS receiver to determine its location, 
speed and direction. 

GSM Global System for Mobile Communication, a standard for mobile phones and networks.

HTTP HyperText Transfer Protocol (HTTP) is the underlying protocol used by the World Wide Web. 
HTTP defines how messages are formatted and transmitted, and what actions Web servers and 
browsers should take in response to various commands.

HTTPS Secure HTTP (HTTPS) is the encrypted version of HTTP. It utilizes SSL technology to encrypt 
the connections.

I/O Input/Output

IMEI The International Mobile Equipment Identity is a number unique to every GSM and UMTS 
mobile phone.

IMlet suite An IMlet suite consists of two files, Java Application Descriptor (JAD) and Java ARchive (JAR). 
The JAD file contains information about the application, such as its name and version. The JAR 
file contains the Java application (one or more IMlets) and its resources.

IP Internet Protocol (IP) is a data-oriented protocol used by source and destination hosts for 
communicating data across a packet-switched internetwork. It is defined in RFC 791.

IP address Internet Protocol address is a unique address that certain electronic devices use in order to 
identify and communicate with each other on a computer network utilizing the Internet Protocol 
standard (IP) — in simpler terms, a computer address. Any participating network device — 
including routers, computers, time-servers, printers, Internet fax machines, and some telephones 
— can have their own unique address.

MES Module Exchange Suite is a tool for copying files between PC and Cinterion TC65i GSM 
module used in Aplicom A1 and Cinterion EGS5 GSM module used in Aplicom A9.

Modem Modulator/demodulator (modem) is a device that modulates an analog carrier signal (sound), 
to encode digital information, and that also demodulates such a carrier signal to decode the 
transmitted information. The goal is to produce a signal that can be transmitted easily and 
decoded to reproduce the original digital data. Primarily used to communicate via telephone lines,
modems can be used over any means of transmitting analog signals, from driven diodes to radio.

OTAP Over-the-Air Provisioning is a method for installing and deleting Java application from mobile 
devices. OTAP is documented in IMP-NG 1.0 specification (JSR 228).

RAT Radio Access Technology is the underlying physical connection method for radio based network. For
example 2G and 3G.

Servlet A Java program that runs on web server within a servlet container (such as Apache Tomcat) and 
provides additional features to the server.

SFTP SSH File Transfer Protocol or SFTP is a network protocol that provides file transfer and 
manipulation functionality over any reliable data stream. It is typically used with the SSH-2 
protocol to provide secure file transfer, but is intended to be usable with other protocols as well.

SSH Secure Shell or SSH is a network protocol that allows data to be exchanged over a secure 
channel between two computers. Encryption provides confidentiality and integrity of data. SSH 
uses public-key cryptography to authenticate the remote computer and allow the remote 
computer to authenticate the user, if necessary.

SMS Short Message Service (SMS) is a service of the GSM network allowing text messages of up to 
160 characters to be sent and received via the network operator's message center to a mobile 
phone, or from the Internet, using a so-called "SMS gateway".

SW SoftWare 

TCP Transmission Control Protocol (TCP) is a connection-oriented, reliable delivery byte-stream 
transport layer communication protocol, currently documented in IETF RFC 793. It does the task 
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of the transport layer in the simplified OSI model of computer networks.

TCP/IP Transmission Control Protocol / Internet Protocol, TCP-over-IP. See TCP.

UDP User Datagram Protocol (UDP) is a minimal message-oriented transport layer protocol that is 
currently documented in IETF RFC 768.

URL Uniform Resource Locator. A string of characters that represents the location or address of a 
resource on the Internet and how that resource should be accessed. World Wide Web pages are 
assigned a unique URL

UTC Coordinated Universal Time. The primary time standard by which the world regulates clocks 
and time. 

well-formed XML A well-formed XML document conforms to all of XML's syntax rules. For example, if an element
has an opening tag with no closing tag and is not self-closing, it is not well-formed. A document 
that is not well-formed is not considered to be XML; a conforming parser is not allowed to 
process it.

wizard A wizard is a user interface element where the user is led through a sequence of dialogs. Unlike 
most modern user interface paradigms, the user is forced to perform the task in a specific 
sequence in order to ease the performance of the task.

WLAN Wireless Local Area Network

XML Short for eXtensible Markup Language, a specification developed by the W3C. XML is a pared-
down version of SGML, designed especially for Web documents. It allows designers to create 
their own customized tags, enabling the definition, transmission, validation, and interpretation of 
data between applications and between organizations.
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